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Module 1:  

The Basics of Revit Structure 

This module contains: 

 Section 1: Introduction to Revit Structure 
What is Revit Structure? 
Revit Structure Projects 
The Revit Structure Interface 

 Section 2: Setting up Levels and Working with Views 
Creating and Using Levels 
Creating Elevations 
Creating Sections 
Creating Callouts 
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Section 1: 
Introduction to Revit Structure 

In this section you will learn: 

 About Revit Structure and what it can do 

 An overview of the interface 

 How to start Revit projects 

 About General drawing and editing tools 
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What Is Revit Structure? 

Revit Structure is a modeling program. This means that everything placed 
into a model simulates a true building material. It is important to note that 
there is a distinct difference between the term modeling and the term 3D. 
While Revit Structure has many advanced 3D capabilities, it is foremost a 
modeling program. Most of your modeling occurs in a 2D environment, 
with 3D views easily accessible at any time. 

BIM and Structural Engineering 
BIM stands for Building Information Modeling. BIM is the process of 
creating a single, database-driven model by placing actual building 
components and materials. 

Therefore, for the structural engineer and designer the BIM model does 
not stop at the actual building. Since the components used in the model 
represent real-life members, you can design for stresses as you draft and 
vice-versa. Additionally, in a Revit/BIM environment when beams are 
attached to columns, and columns to grids, the application understands 
that these items belong together. In plan, if a gridline moves, so do the 
columns and subsequently the beams. In elevation, if a level moves, the 
columns increase in length and any framing on that floor moves with it. 
Revit also automatically updates the column schedule to reflect the 
change. 

Drawings are now based on a model that is as close to an actual building 
as possible. A design change can influence the building in another area. 
This is known as parametric design. The move to this kind of modeling is 
becoming the industry standard. As BIM applications become smarter, so 
does the industry. 
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Revit Structure Projects 

A project is a complete description of a building and the information 
associated with it for displaying 2D and 3D views, as well as schedules. 
When you open a Revit Structure project file, it opens the entire project or 
building model. You can then work in different views, such as plan, 
section, elevation, and 3D model, all within the same project. 

 All of the views are associative. What you change in one is 
automatically updated in all of the others. For example, if you add an 
opening to a wall in a plan view, it also appears in the related elevation 
view and possibly in a lintel schedule. 

 You create construction drawings on sheets in a Revit Structure project 
using the various views. Callouts of details and elevations are 
automated with tags and titles on the sheets. 

File Types 
The following explains each Revit file type: 

.RVT The file format of a Revit model. There are three separate Revit applications: 
Revit Structure, Revit Architecture, and Revit MEP. Each of these applications 
saves as the RVT format. Each file can be opened directly in any of the three 
applications. RVT files can also be inserted and linked into one another. This is 
crucial for coordination between disciplines. 

.RFA The file format of a Revit Family. These files can be opened directly, inserted, 
or loaded into an RVT file. 

.RTE The Revit template file. When a new model is started, an RTE file is used to 
create the model. When you save the file, it is saved as a new RVT model. This 
file contains all of your company’s standards and settings. Views, sheets, and 
families should be set up and ready to use. 
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Types of Elements 
There are five main types of elements in a Revit Structure project, as 
explained below: 

Host Host elements are the built-in-place construction objects, such as 
floors, walls, roofs, ceilings, stairs, and ramps. They can stand alone in 
the project. 

Component Component elements are objects that need to be attached to host 
elements, such as doors, windows, and railings, as well as stand-alone 
items, such as furniture and equipment. 

View Views enable you to see and manipulate the project. For example, you 
can view and work in floor plans, ceiling plans, elevations, sections, 
schedules, and 3D views. You can change a design from any view. All 
views are stored in the project. 

Datum Datum elements define the project context. These include levels for the 
floors, column grids, and reference planes that help you draw. 

Annotation Annotation elements are 2D objects that you place on views to define 
the information drawn in the project. These include dimensions, text, 
tags, and symbols. The view scale controls their size. 

     

MODEL  
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Families 
You create a Revit model by adding pre-defined items (e.g., columns, 
beams, joists, trusses, footings, pile caps, doors, windows, openings, brace 
plates, detail components, and even items such as annotations). These 
items are called Families and they are a single file (RFA file extension) 
that can contain hundreds of choices when being added to the model. For 
example, one type of column family file is called W-Wide Flange-
Column.rfa, as shown below. This file is broken down into multiple sizes 
for wide flange columns. When creating a Revit model family, members 
are selected and loaded as needed to create the model. 

 

 Revit Structure includes many families in its Library. You can also 
create your own family types. 

Items such as walls, floors, and roofs are called system families. This type 
of family is not loaded as a separate entity but is inherent to the project. To 
create a new system family, an existing item is copied and re-defined to fit 
the project’s specific needs. System families can also be copied to the 
Windows clipboard and pasted into another project. 
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The Revit Structure Interface 

Revit Structure models are entirely driven by placing components; 
therefore, the interface is different from the AutoCAD interface. There is 
no command prompt, no layers, and fewer icons. Revit Structure is an 
application designed solely for structural design. 

 

Menus 
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Menus in Revit Structure are similar to standard Windows menus. The 
Revit menus include the common File, Edit, and View menus. In addition, 
you can access more commands in the Design Bar. 

Hint: Menu Shortcuts 

Revit has a file called Keyboardshortcuts.txt, located in C:\Program 
Files\Revit Structure 2009\Program\. This file is similar to the 
Acad.pgp file in that you can create shortcuts to your favorite 
commands. 

For example, if you wanted a shortcut to the Copy to clipboard 
command, open the Keyboardshortcuts.txt file and scroll down to the 
following line: 

; ""  menu:"Edit-Copy to Clipboard" 

Replace the ; "" with “CL” so the string appears as follows: 

"CL"  menu:"Edit-Copy to Clipboard" 

 

General Toolbars 

 
 

Many of the toolbars available in Revit 
Structure are different from most other CAD 
applications. Right-click on any toolbar to see 
a list of toolbars. You can toggle their display 
on and off by adding and removing the check 
marks in the shortcut menu. 
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Standard 

 

The Standard toolbar consists of the basic tools found in any PC-based 
application. This toolbar includes the following options: 

 File management tools: New, Open, Save, and Print 

 Clipboard tools: Cut, Copy, Paste, and Delete 

 Undo/Redo 

 Project Browser (toggle on and off) 

 Help by selection 

View 

 

The View toolbar enables you to control the visual movement of the 
model. This toolbar includes the following options: 

 Steering Wheels 

 Zoom 

 Thin Lines (Used to display line thickness. With this function off, the 
model can be viewed with all lines and objects on the same line 
weight.) 

 Show Mass 

 3D View 

Edit 

 

The Edit toolbar enables you to modify your model using a variety of 
manipulation techniques. 
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Tools 

 

The Tools toolbar aids in the placement and aesthetic modification of 
items in a model (e.g., work plane creation and visibility, spell check, 
measuring tools, etc.). This toolbar is often overlooked, but can provide 
some very powerful tools. 

Tools 2 

 

The Tools 2 toolbar is designed specifically to copy framing members and 
setting rebar cover to elements. It is crucial to the drafting process. 

Worksets 

 

The Worksets toolbar enables file sharing among multiple people who are 
working on the same project. When more than one person is working on a 
project, worksets and file sharing are enabled. 

Design Options 

 

The Design Options toolbar enables the design team to keep their design 
changes and possible design options in one model. 

 Options Bar 

 

The options available in the Options Bar depend on the component or 
command you are currently operating. Refer to this toolbar for additional 
functionality to manipulate your model. 
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Design Bar 
The Design Bar is the backbone of Revit. Most commands are initiated 
from this toolbar. Once a command is initiated, you can set options in the 
Options Bar. 

The Design Bar is divided into nine categories (tabs). When Revit is first 
loaded, not all categories are visible. To view all of the available 
categories, right-click on any visible column header and select the tab you 
want to add to the Design Bar. 

   

The header of each category is called a tab. Each tab contains a number of 
commands related to the tab’s description. For example, you can find the 
Elevation, Section, and Camera commands in the View tab. You might 
run into the same command on different tabs. These commands are 
identical and are only duplicated for convenience. 

To Use the Design Bar: 
1. Select the Basics tab in the Design Bar. 
2. Start a command by clicking the button, such as . The 

Options Bar now opens to aid in the placement of a structural column. 
3. The first item in the Options Bar is called the Type Selector. When a 

command is activated, Revit provides a type for the specific command. 
This list reflects the items that are currently loaded into the model. 
Select a column from the list. 
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4. To the right of the Type Selector, click  (Element Properties). 

Study some of the items, and click . 

 

5. Select a spot on the screen for the placement of the column. The 
command keeps running. 

6. Click  in the Options Bar. You should be directed to the 
Imperial Library or your company’s default library. 

7. Select Structural>Columns>Steel and select (do not double-click) 
one of the column types. 

 

Notice the list of columns within that category. 
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8. Click . In the Options Bar, you can place the columns 
freely or use an existing grid system. You can place an architectural 
column and change the height and depth. 

 

Revit always remains in a command. There are three ways to exit a 
command: 

- Press <Esc>. 

- Start another command. 

- Click  in the Design Bar (recommended). 

9. Click  in the Design Bar or press <Esc> twice to exit 
the command. 

The Project Browser 
Revit, like any drafting program, deals with plans, elevations, sections, 
details, schedules, and sheets. Most of these items are at different scales. 
Revit organizes them in the Project Browser. To go to one of the items, 
double-click on it in the Project Browser. These views all reside in the 
same file. 
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Views 
A Revit Structural project is one model. All plans, elevations, sections, 
and details are contained in the model. Revit breaks each of these items 
down into views. 

Based on what the view represents, Revit includes it in the appropriate 
category. For example, Level 1 is categorized under floor plans. If you 
were to create an elevation, the new view is placed under the Elevations 
category. 

Views can be created using the View tab in the Design Bar, by copying an 
existing view, or by adding a level in the elevation. 

The view categories that are available include the following: 

 Structural Plans 

 3D Views 

 Elevations (Building Elevation) 

 Elevations (Interior Elevation) - This includes bracing elevations. 

 Sections (Building Section) 

 Sections (Wall Section) 

 Detail Views 

 Drafting Views 

 Renderings 

 Graphical Column Schedules 

 Walkthroughs 

 Legends 

 Schedules/Quantities 

 Sheets 

 Families 

 Groups 

 Revit Links 
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Some of the less common categories are not shown if that type of view 
does not exist. For example, if no renderings of the model have been 
created, there the Renderings category is not shown. 

The Project Browser is set up as a tree similar to Windows Explorer, 
where categories can be expanded and collapsed. This is useful when you 
have a large project and are accumulating a large number of views. 

To Navigate the Project Browser: 
1. Find and expand a category, such as Elevations (Building elevation). 
2. Double-click on a view (e.g., Building Elevation). The building 

Elevation View is now open, as shown below. 
3. To open another view, double-click on the name in the Project 

Browser. The views shown below are the default views supplied with 
Revit Structure. You can also create and name your own views based 
on your project. 
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View Windows 
As views are opened from the Project Browser, a new view window 
appears. Each window contains its own view properties. It is here that you 
can apply aesthetic properties. 

 

Window Pull-down Menu 

 

Each model that is open can each have multiple windows open, which can 
affect the speed at which Revit performs functions. It is recommended that 
only the necessary windows are open. To control this, select the Window 
pull-down menu and notice the list of open views at the bottom of the 
menu. Select Close Hidden Windows to reduce memory usage. 
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The remaining options in the Window pull-down menu enable you to 
configure the window display (Cascade, Tile, Arrange Icons), control the 
toolbars that are displayed, and navigate between active windows. 

View Control Bar 

 

The View Control Bar is at the bottom of the view window. This toolbar is 
mainly responsible for the display of the model for a particular view. 
These settings are permanent, and affect the plotted results of your model. 
Select these settings with careful consideration. 

Scale: Controls the size of annotations and symbols at the specified scale. 
Click this button to select from a list. If you change the scale, you need to 
inspect the view. You might need to rearrange some items based on the 
new scale value. 
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Detail Level: Determines the level in which the finite graphics of an item 
are viewed. There are three detail levels: Coarse, Medium, and Fine. 
Viewing a model at a Fine detail level shows everything about the 
components, but affects the speed at which you can pan and zoom the 
model. 

   

Model Graphics Style: Determines the display style of the model. There 
are four model graphics styles to select from: Wireframe, Hidden Line, 
Shading, and Shading with Edges. 

 

 Wireframe: Default style for a new view. 

 Hidden: Typically the first choice for plans and elevations. Any 
obscured objects show as hidden line, while objects that are not 
obscured show as continuous lines. Different displays in a typical 
foundation plan view are shown below. One is shown wireframe and 
the other is shown as hidden. 

  
Wireframe     Hidden 
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 Shading: Shown for 3D illustrations. It shades the model but does not 
show the lines defining the objects being shaded. It can also be shown 
in elevation and plan, but becomes cumbersome when it comes time to 
plot the model. Shading in plan or elevation using the Display toolbar 
is not recommended. 

 

 Shading with Edges: The natural choice for 3D. It shades the model 
and leaves the outline edges. This mode is also not recommended for 
plan and elevation. You can use a simple hidden view on 3D and 
perspective views. 

 



Revit Structure 2009 Fundamentals 

1 - 20                                              © 2009 - Do not duplicate 

 Shadows: Used for presentations. Showing a shadowed model slows 
the system dramatically. 

  

 Do Not Crop and Hide Crop Region are designed to behave similar 
to viewports in AutoCAD. Cropping a plan region involves showing 
the crop region and moving the boundary to the desired location. 
Column bubbles and grids still display if this is done properly. 
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 Temporary Hide/Isolate and Reveal Hidden Elements are used 
frequently. In some cases, you need to hide specific elements from 
view to enable you to work on the model more efficently. You might 
also be required to see which elements have been turned off in the 
view. These two options enable you to toggle through the visibility 
modes to see what has been turned off. It also enables you to select 
items to be removed from view. This function only hides items in a 
view; it does not remove them from the actual model. 

 

When an object is hidden from view, the Sunglass icon turns to a turquoise 
color. A turquoise band around the entire view indicates that some 
elements are temporarily turned off. 

 

To reveal hidden elements, click the Lightbulb icon. It turns to a magenta 
color and the hidden elements appear in the same color. You can then 
select the Sunglass icon and reset the view. You can also make the hidden 
objects become permanently hidden. 
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View Properties 
Each view has independent properties, enabling different graphical 
representations based on that view’s function. Views can also be 
duplicated, enabling different sets of information to be displayed on a 
sheet. For example, a foundation plan can be copied to show slab 
reinforcing next to a dimensional plan on a sheet. 

There are two ways to access the properties of a view: 

 One way to access view properties is to right-click anywhere in the 
view window and select View Properties… 

 

The properties of the view are displayed. Some of them are a duplication 
of the View Control toolbar. 
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 The second way to access view properties is to select a floor plan in 
the Project browser, right-click and select Properties. This is the same 
as right-clicking in the view window. 

The shortcut menu also has an option of duplicating a view. This makes 
a copy of the view. You can then add annotations and display 
configurations independent of any other view. 

 

Duplicating Types: 

Duplicate: Creates a copy of the view with only the building elements 
included. Building model objects change in all views automatically, but 
view-specific changes made to the new view are not reflected in the 
original view. 

Duplicate with Detailing: Creates a copy of the view and includes 
view-specific elements (such as tags). Any new annotation and specific 
objects in the new view are not reflected in the original view. 

Duplicating as a Dependent: Creates a copy of the view and links it to 
the original view. Changes made to the original view are also made in 
the dependent view and vice-versa. Use dependent views when the 
building model is so large that you need to split the building up on 
separate sheet, with views that are all at the same scale. 
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  Practice - Introduction to Revit Structure 
In this practice you will open an RVT file from the class directory and 
explore the tools used to navigate a Revit Structure project. This practice 
is designed for you to explore the functionality of the Project Browser and 
the command interface. 

 

Task 1 - Navigate Revit Structure 
1. Open the project file Syracuse Suites.rvt, found in your class 

directory. The project opens to the 1 FIRST FLOOR framing plan. 

2. If the Project Browser is not displayed, click  in the Standard 
toolbar. 
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3. In the Project Browser, double-click on the 00 GROUND FLOOR 
structural plan. It opens to a plan showing footings and foundation 
walls. 

4. In the View Control toolbar, locate the Model Graphics Style icon and 
change the model graphics to Hidden Line. 

 

  

5. In the Project Browser, double-click on the 00 T.O. FOOTING 
structural plan. Notice that the foundation walls are in-filled with the 
appropriate concrete hatch. The strip footings and spread footings also 
show as continuous lines because there is no slab to obscure them. 

6. Type ZE. This zooms the extents of the view. (ZA zooms all). Find the 
section marker that extends vertically along the model. 
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7. Double-click on the bubble. This opens the LATITUDINAL 
SECTION. 

8. In the Project Browser, navigate to the Sections (Building Section) 
category and notice that LATITUDINAL SECTION is bold. You can 
navigate Revit by either double-clicking on the item in the Project 
Browser, or by using the graphical annotation elements in the model. 

9. Zoom in on the area where the callout has been placed. 

 

10. Double-click on the bubble. This opens the TYPICAL EDGE 
DETAIL. 

11. Select the reinforcing. It is not just donuts and thick polylines. 

12. Click  (Element Properties) in the Options Bar. Remember that 
when an item is selected, the Options Bar changes to aid you in the 
design of that specific element. 
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13. Scroll down to the Instance Parameters of the area reinforcing. The 
choices made here will drive the model. When it comes time to label 
the sections and details, these values become annotations. If these 
values change, they only need to be changed in one place. The new 
values are then propagated to all the views. Any change made here is 
only applied to the element that is selected. In this case, only the first 
floor area reinforcement changes. 

 

14. Click  to access the Type Parameters. Any change 
made to these parameters changes all area reinforcing in the entire 
model. In this case, the area reinforcing is changed for all floors. 

15. Click . 

16. Press <Esc> twice to clear the selection. 

17. Select one of the bolted connections. This is a detail component. 

18. Look in the Options Bar. It has loaded the options specific to this item. 

19. Press <Esc> to clear the selection. 

20. Double-click on the first floor datum mark. This up the 01 FIRST 
FLOOR structural plan. 
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21. Expand the Window pull-down menu. There is a growing list of 
opened windows. This can quickly become a management issue once 
the model starts growing in size. You can select Close Hidden 
Windows so that only the current window remains open. 

 

22. Click  in the View toolbar. Type WT. You now have two 
visible windows. This view configuration is useful when placing items 
in a model. 

23. Click in the 3D view. 

24. Press and hold <Shift> and then press and hold the wheel button on 
your mouse. Move the mouse to dynamically view the 3D model. 

25. Click  (Close) to exit the 3D view (this also works when many 
views are open). 
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26. Select File>Close to exit the project. Do not save changes. 

 

Task 2 - Create a Project 

1. Click  (New) and then  (Save). 

2. Browse to your class directory. 

3. Click  (New Folder). Label the new folder with your name. 

4. In the lower left corner click . 

5. In the File Save Options dialog box, set the Maximum number of 
backup(s) to 1. 

 

6. Click . 

7. Name the file Class Model. 

8. Click . 
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Self Check: 
Introduction to Revit Structure 

1. What is the name of the toolbar on the left side of Revit Structure that 
contains the design tabs? 

2. What is the name of the dialog box that enables you to access the 
project and its views? 

3. What is the name of the toolbar that changes according to the current 
command? 

4. Can you change how Revit controls the display of a view? How? 

5. When a component is brought into a Revit model, what is this 
dynamic component called? 

6. Can you open views by double-clicking on a datum or section? 
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Section 2: 
Setting Up Levels and Working with 
Views 

In this section you will learn how to: 

 Create and use levels 

 Create elevations 

 Create a section view 

 Create callouts 
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Creating and Using Levels 

One of the greatest benefits to using Revit is the ability to control datum 
elevations in real-time by using levels. Having this functionality in a single 
model without the need for external referencing systems is also 
advantageous. From a simple tool shed to a skyscraper, Revit is designed 
to manage an entire project, not just parts of a building. By adding and 
managing all of the building’s levels in a single file, Revit increases 
efficiency in the typical workflow of a project. More time can be spent 
designing and less time spent managing files and folders. 

 

To Create a Level 
1. Create a new model in Revit Structure. 
2. Double-click on the South Elevation under the Building Elevations 

category. Two elevations are present. This is typical of a default Revit 
template. Your company might have set up a different project 
template. 

3. Click  in the Basics tab in the Design Bar. 
4. Click  (Pick) in the Options Bar. 
5. Type 12 in the Offset field in the Options Bar. 
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6. Move your cursor over the Level 2 elevation line. A blue alignment 
line appears. If you move your cursor to either side, the alignment line 
moves with it. When you see the alignment line appear above Level 2, 
select it. Level 3 appears. 

 

7. Notice a new floor plan has been created for this level. Click 
 and select Level 3. 

 

The following items that appear enable you to do the following: 

 The Checkmark icon that appears above the bubble is a toggle that 
controls whether the bubble is shown at that end of the level. 

  The 3D icon controls whether any movement or adjustment is 
pushed down to other elevations. If you select this icon, it displays as 
2D. This is highly recommended in elevation, as it has a negative 
effect on other views. 

  The Padlock icon controls whether the level datum is positioned 
next to other datums. If the lock is on, you should see the blue 
alignment line. If the datum is moved, all datums move. This helps 
maintain conventional drafting standards. If the lock is shown 
unlocked, the datum moves independently of the other levels. 

  The Blue circle icon at the base of the datum enables you to drag 
the datum to a new location. 
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 The blue dimension that appears between the levels can be edited. This 
is called a temporary dimension. Remember that any blue item can be 
modified. 

 

 The Dimension icon makes the temporary dimension permanent. If 
this occurs, you can still modify the increment by selecting the level. 
The permanent dimension temporarily turns blue enabling you to edit 
the value. 

 Additionally, the actual datum elevation can be selected and modified. 
Note that doing do affects the entire model. Be careful if you have to 
change the distance of an elevation. If it is late in the project,  
non-parametric drafting items might exist. Changes might leave these 
items in undesirable locations. Be sure to do a review of the project to 
ensure that all is as required. 

 

  The Add Elbow icon enables you to add a jog to the level line. In 
tight spaces, this becomes crucial. 

8. Select the 12’-0” dimension and change it to 10’-0” (You can just type 
10). The level and anything associated with that level moves. 

9. Rename Level 3 as Roof. 
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10. A message appears, asking if you want to rename the corresponding 

views. Click . 

 

The Level 3 view under Structural Plans located in the Project Browser 
has also been renamed as Roof. 

11. Select the Level 1 level line. 

12. Click  and select a point anywhere along the Level 1 line. 
Move your cursor straight down. 

13. Select the Constrain and Copy options in the Options Bar. Clear the 
Multiple option. 

 

14. Type 10’-0” at the cursor. 

 

15. Once the level is copied, rename it as T.O. footing. 
16. No additional floor plans have been added to the Project Browser. This 

is because you only copied a level. You did not create it using the 
conventional Level command. Therefore, you need to create a floor 
plan based on the new level. 

17. Select the View tab in the Design Bar. Click . 
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18. Select the T.O. Footing level in the New Plan dialog box. 

 

19. Click . A new floor plan now appears in the Project 
Browser 

20. Close the project without saving. 



The Basics of Revit Structure 

© 2009 - Do not duplicate                                                                                                  1 - 37 

Creating Elevations 

Two kinds of elevations can be created in Revit: Building elevations and 
Framing elevations. Each one is similar, but serve a different purpose. A 
building elevation can be placed freely, whereas a framing elevation 
requires you to select a specific framing bay. 

To Create Building Elevations 
1. Open the file Bracing.rvt. 
2. Select Level 1 in the Project Browser. 
3. Click  in the View tab in the Design Bar. 
4. Select a location west of the building to place the elevation. The arrow 

points toward the building. 

 



Revit Structure 2009 Fundamentals 

1 - 38                                              © 2009 - Do not duplicate 

5. A building elevation now appears in the Project browser. Right-click 
on the new building elevation and select Rename… Rename it as 
West Elevation. 

 

6. Select the section you just added in the Level 1 floor plan. The section 
consists of two different parts. One is the bubble. The bubble holds the 
sheet information when the view is added to a sheet. 

  

The second is the target. The target holds the physical properties of the 
view that it is calling out. The elevation markers are not just symbols. 
They hold the information for the corresponding view. If an elevation 
marker is deleted so is the view to which it was pointing. Additionally, if 
the target is moved, it must be selected using a window. Both items must 
move together or unexpected results occur. 
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7. Press <Esc>. This time, only select the bubble. The familiar blue 
checkmarks appear. If you turn on the other three targets, you create 
three additional views. 

8. Clear the West Elevation target. 

 

9. A Warning dialog box opens indicating that you are deleting a view. 

Click . 

 

10. If you accidentally delete the view, click  (Undo). 
11. Select the bubble again. The Rotate  icon appears. Use it to rotate 

the position in which the view is being taken from. 

Be careful when using this functionality. This determines the exact 
rotational value of the elevation. If this is not accurately perpendicular to 
the structure, the view is off. If an elevation on an angled or radial surface 
is required, click  and hover your cursor over the 
side of the building on which you want the elevation. It automatically 
positions itself perpendicular to the geometry of the building. 
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12. Press <Esc>. 
13. Select the target. Notice the blue line with the blue grips on the end. A 

dotted line forms a box around a portion of the model. These are your 
view extents, which indicate exactly where the perimeter and depth of 
your elevation are going to land. The resulting elevation is cropped at 
these extents. 

 

14. Select the blue grip ( ) at the top of the line. 
15. Move it down closer to the area on the west side of the building. 
16. A Drag icon ( ) appears in the middle of the line to indicate the view 

depth. By default, this lands directly on a framing member. It 
determines the depth to which the elevation clipped. You can adjust it 
as needed. Press <Esc>. 

17. Double-click on West Elevation in the Project Browser or double-click 
directly on the elevation target in the floor plan to open that view. 
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18. In this elevation view, the default detail level is Coarse. At the bottom 
of the view, change the detail level to Fine . 

 

19. Notice a line at the perimeter of the view. This is called a crop region. 
The rectangle directly relates to the grips at the end of the elevation 
target in the plan view. By moving the crop region in elevation, you 
are moving the extents in plan. 

20. Type WT to tile the elevation and the plan. 
21. In elevation, select the crop region. 
22. Click in the plan view. The elevation and elevation boundary lines are 

selected. Remember that changes in one view have a direct effect on 
many other views. 

 

23. Maximize the west elevation ( ). 
24. Define the crop region using the View Control toolbar. You can define 

it using the following tools: 

  (Do not crop): Turns off cropping. If you select an elevation 
marker in plan, you do not see the blue grips and the extent arrows. 
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   (Hide/Show Crop Region): This retains the cropping but 
removes the box. 

25. Click  (Show Crop Region) to show the crop region. 
26. Right-click anywhere in the view and select View Properties… 

 

27. Additional Instance Parameters pertaining to the extents of the view 
appear in the View Properties dialog box. Crop View and Crop 
Region Visible are both controlled by the icons in the View Control 
toolbar. 

28. The Annotation Crop enables the designer to retain text and symbols 
outside of the area that shows the lines of the building. Toggle this 

parameter on and click . 
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29. Select the crop region. There is an additional region. Only annotative 
items appear in the area between the annotative region and the crop 
region. 

 

30. Right-click and select View Properties again. 
31. Click  to open the Far Clipping dialog 

box. 
32. Select the No Clip option. 

 

33. Click . 
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34. Click  again. The elevation now looks at the entire 
structure. 

 

To Create Framing Elevations 
A framing elevation is set up to capture an elevation of a single area in a 
building. The most common use for a framing elevation is to generate 
bracing elevations and schematics. The output is the same as a building 
elevation. Both are views generated from a plan and both have the same 
properties. 

1. Select Level 1 under Structural Plans in the Project Browser. 
2. Zoom the area along column line 6 between column lines 2 and 3. 
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3. Click  in the View tab in the Design Bar. 
4. Hover your cursor over column line 6 between 2 and 3. An elevation 

appears. 
5. Once the elevation marker appears, select the line (you can adjust it 

after placement if needed). 

 

6. Select the target. The extents focus only on the bracing bay. 
7. A new interior elevation appears in the Project Browser. Right-click 

on it and rename it as Bracing Bay A. 
8. Double-click on Bracing Bay A to open it. 

 

9. The crop region is too tall in the default view. Select it and stretch it 
down to a reasonable area. The grid bubbles move with it, keeping 
them visible. 

10. Change the detail level to  (Fine). 
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11. Drag ( ) the crop region to the left to show both bays. 

    

12. The framing elevation has been created. Remember that you can drag 
the elevation datum lines out of the way for a more organized view. 
Also remember to switch them to 2D, so that you do not affect the 
other elevations. 
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Creating Sections 

Creating sections is almost identical to creating an elevation. The same 
concept of creating a new view still applies. Sections are controlled by the 
crop region, as well as depth clipping. A section is simply an elevation 
taken through the middle of a building. 

To Create a Section 
1. Open the first floor plan. 
2. Click  in the View tab in the Design Bar. 
3. Select a point to the right of column line 1 and above column line 8. 

 

4. Select a second point parallel with column line 1 and below column 
line 6. 
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5. The extents of the section are probably outside a reasonable range. 
Select the drag ( ) icon to the right of the view range window and 
drag it back to between column lines 1 and 2. 

6. With the section selected, you see the following blue icons: 

  The Cycle icon enables you to toggle through the head, tail, or 
blank options. The cycle icon appears on both sides of the section line. 

  The Flip arrow changes the direction of the section. 

  The Break icon enables you to break section lines to avoid clutter 
and multiple annotation lines in the model. Once the Break icon is 
selected, you can slide the section lines to clear the building using the 
newly formed grips. 

 

7. Click the  (Break) icon. This joins the lines back together. 
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8. With the section selected, click  in the Options Bar. 

9. Your cursor turns into the  symbol. Select the section line 
anywhere along its length. The segment of the section now follows the 
movement of your cursor. 

 

10. Exit the command. If the line was split, you can drag the split section 
and realign it. 

11. A new building section appears in the Project Browser. Rename it as 
Col A Section. 
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12. Double-click on Col A Section to open it. 

 

13. Change the detail level to  (Fine). 
14. Zoom in on any area. The 1/8” line weight seems heavy. 

15. Click  (Thin Lines). 
16. Close the section. 
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Creating Callouts 

Another way to generate a view is to create a callout. This command clips 
a region, copies it to a new view, and increases the scale by a factor of 2. 
Revit Architecture uses this feature predominantly for plan work, while 
Revit Structure uses it for sections and elevations. 

To Create a Callout 
1. Open the Bracing Bay A elevation. 
2. Click  in the View tab in the Design Bar. 
3. Draw a window around a single bracing occurrence, as shown below. 

 

4. Place the callout bubble in an appropriate location. Notice the blue 
grips. This indicates that you can control the size and positioning of 
the bubble after placement. 

5. Select the Callout of Brace Bay A elevation in the Project Browser. 
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6. Select the crop region and adjust it so that only the pertinent framing 
displays. You can also drag the elevation and grid lines out of the way. 
When you select them, the default changes to 2D. 

 

Callouts and sections contain text and dimensions that are unique to these 
views only, while the physical geometry is shared throughout the model. 
Any modification to the actual model requires an investigation of these 
views to determine if the text still applies, or if the text is still appended to 
the model. 
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 Practice - Creating Levels, Sections, and Callouts 
In this practice you will add levels to your model. Levels can be linked 
from a Revit architectural model, or they can be added one by one in the 
structural model. Care should be taken either way in regards to that 
level’s actual height. Copying the architectural levels would put you at a 
finish floor system rather than a top of steel elevation. 

Task 1 - Create Levels 
1. Open the file Syracuse Suites - Structural-01.rvt. 

 

2. Activate the South Elevation. 

3. Zoom in on the 1st Floor elevation. This has been brought in from the 
architectural model. 

4. Click  in the Basics tab in the Design Bar. 

5. Click  (Element Properties) in the Options Bar. 

6. Click . 
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7. Toggle on the Symbol at End 1 Default option. 

8. Click  twice. 

9. Click  (Pick) in the Options Bar. Type 6” for the Offset. 

 

10. Select the architectural 1st floor level. Your structural level is the top 
of steel. 

11. Select the blue alignment line once it appears below the level. 

 

12. Rename the new level as 1ST FLOOR. 

13. Repeat the process for all of the floors. You can skip the parapet level. 
Do not forget the 00 GROUND FLOOR and the T.O. FOOTING 
levels. These levels do not require an offset. 

14. Select the 00 GROUND FLOOR plan. 

15. Right-click on one of the foundation walls and select Select All 
Instances. 

16. Click  (Element Properties). 
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17. Change the Base Constraint to T.O. FOOTING and the Top 
Constraint to Up To level: 00 GROUND FLOOR. 

 

18. Click . 

19. Right-click on a column and select Select All Instances. 

 

20. Click  (Element Properties). 

21. Set the Base Constraint to 00 GROUND FLOOR and the Top 
Constraint to Roof. 

22. Click . 

23. Activate to the South Elevation. 
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24. Delete the existing Level 1 and Level 2. You have replaced them with 
new levels. 

 

25. Save the model. 

Task 2 - Create Sections 
1. Select the 00 GROUND FLOOR in the Project Browser. 

2. Click  in the Basics tab in the Design Bar. 

3. Place a horizontal section through the middle of the building from left 
to right. 

4. Select the section and break ( ) it in the middle. 

5. Select the blue grips ( ) and drag the lines to an appropriate position. 

6. On the right side of the section, select the Cycle icon ( ) to turn the 
right grid bubble on. 

7. Right-click on the new section in the Project Browser and name it 
Longitudinal Section. 

 



The Basics of Revit Structure 

© 2009 - Do not duplicate                                                                                                  1 - 57 

 

8. Add another section from top to bottom through the middle of the 
building. 

9. Break the line ( ). 

10. Drag the grips ( ) to an appropriate position. 

11. Cycle ( ) through the bottom tail until you see the target. 

12. Rename the section as Latitudinal Section. 

13. Open the Longitudinal Section. 

14. Turn the detail level to  (Fine). 

15. Select the crop region, and stretch it up so all of the levels are visible. 

16. Stretch it to the left and right, as needed. 

17. Type VG to open the Visibility Graphics dialog box. 

18. Select the Revit Links tab. Clear the Syracuse Suites Architectural 
item. 

19. Click . 
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20. Stretch the grid bubbles to the top of the view by selecting them and 
moving the blue grip. 

21. Open the Latitudinal Section. You can double-click it on the section 
marker or in the Project Browser. 

22. Repeat the previous steps to clean up the view. 

23. Click  in the View tab in the Design Bar. 

24. Draw a window around the lower left end of the foundation wall. This 
is the defining window for a callout. After the callout is placed, several 
blue grips appear. This enables you to stretch and manipulate the 
callout window. 

 

25. Rename the callout as Typical foundation Detail. 

26. Save the model. 
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Self Check: 
Setting up Levels and Working with 
Views  

1. Levels can be created in a plan view. True or False? 

2. If an elevation symbol is deleted from the plan, what happens to the 
elevation view it corresponds to? 

3. How do you break a section line after you have placed it in the model? 

4. How do you create a framing elevation?




